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Copyright 

The data in this document may not be altered or amended without special notification from ETAS 

GmbH. ETAS GmbH undertakes no further obligation in relation to this document. The software 

described in it can only be used if the customer is in possession of a general license agreement or 

single license. Using and copying is only allowed in concurrence with the specifications stipulated in 

the contract. 

 

Under no circumstances may any part of this document be copied, reproduced, transmitted, stored in 

a retrieval system, or translated into another language without the express written permission of ETAS 

GmbH.  

 

© Copyright 2023 ETAS GmbH, Stuttgart 

 

The names and designations used in this document are trademarks or brands belonging to the 

respective owners. 
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1. Introduction 

1.1. Definitions and Abbreviations 

 

Term/Abbreviation Definition 

ASCET-DIFF 

 

ASCET Difference Browser 

Code Generation 

 

Code generation is the first step in the transformation of a physical model to 
executable code. The physical model is transformed into ANSI C code. 
Since the C code is compiler (and therefore target) dependent, different 
code for each target is produced. 

EHI ETAS Help Desk International 

File extension *.amd ASCET Model Description, XML based description format of ASCET models 

File extension *.axl Archived XML for ASCET  

HW Hardware 

KIR Known Issue Report – For severe Problem Reports which occur after a 
release, ETAS has introduced the Known Issue Report to inform affected 
customer immediately. The current Known Issues of former versions can be 
found on the ETAS website: http://www.etas.com/kir 

PR Problem Report 

SW Software 

Target The hardware a program or an experiment runs on, e.g. MPC55xx, TriCore, 
SH2 

WB Walkback: ASCET system error 

1.2. References 

[ASW_GS_EN] 

ASCET V6.4 Getting Started 

[ASW_INST_EN] 

ASCET V6.4 Installation Guide 

[ASW_ADMIN_EN] 

ASCET V6.4 Administration Guide 

[ASW_AR_UG_EN] 

ASCET V6.4 AUTOSAR User’s Guide 

[ASW_ARCONV_UG_EN] 

ASCET V6.4 AUTOSAR to ASCET Converter User’s Guide 

[ASW_ICON_REF_EN] 

ASCET V6.4 Icon Reference Guide 

[ASW_RP_UG_EN] 

ASCET-RP V6.4 User’s Guide 

 [ASW_SE_UG_EN] 

ASCET-SE V6.4 User’s Guide 

http://www.etas.com/kir
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[ASW_DIFF_INST_EN] 

ASCET-DIFF V6.4 Installation Guide 

 

1.3. Conventions 

The following typographical conventions are used in this document: 

 

OCI_CANTxMessage 

msg0 = 0; 

Code snippets are presented on a gray background and in the Courier font. 

Meaning and usage of each command are explained by means of 

comments. The comments are enclosed by the usual syntax for comments. 

Choose File → Open. Menu commands are shown in boldface. 

Click OK. Buttons are shown in boldface. 

Press <ENTER>. Keyboard commands are shown in angled brackets. 

The "Open File" dialog 

box is displayed. 

Names of program windows, dialog boxes, fields, etc. are shown in quotation 

marks. 

Select the file 

setup.exe 

Text in drop-down lists on the screen, program code, as well as path- and 

file names are shown in the Courier font. 

A distribution is always a 

one-dimensional table of 

sample points. 

General emphasis and new terms are set in italics. 

 

 NOTE 
 

Important hint for the user. 

1.4. User Documentation 

The set of ASCET manuals (see section 1.2) can be found on the DVD installation medium. 

2. Product Definition 

2.1. Functions at a glance 

ASCET is a development environment that enables the specification and implementation of control 

algorithms for embedded systems. ASCET V6.4 forms the core installation and must be installed first. 

The products ASCET-MD (Modeling & Design), ASCET-MDV (Model Viewer), ASCET-RP (Rapid 

Prototyping) and ASCET-SE (Software Engineering) for various micro controller targets can be 

installed on it independently. 

Together with the add-on products ASCET-SCM (Software Configuration Management) and ASCET-

DIFF (Difference Browsing), ASCET forms a complete software development tool-chain 
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2.2. General Description 

2.2.1. Safety Notice 

If ASCET is used to generate code for safety-related applications, the following assumptions are made 

on, and must be validated for, all users: 

• You are a trained software engineer who wants to use the ASCET model-based 

development approach to generate C code for use in a safety-related system. 

• You are a recognized expert in the design and implementation of software-intensive safety-

related systems. You have detailed knowledge about the failure modes of the system you 

are constructing and will have been the author or technical reviewer of the system safety 

case as it relates to aspects of the systems realized in software. 

Further information about the use of ASCET in safety-related applications is available in the following 

documents that are available on request from ETAS: 

• ASCET V6.4 Safety Manual 

• ASCET V6.4. MISRA-C:2012 Compliance Guide 

 

2.2.2. System Prerequisites 

The following minimum system prerequisites have to be met: 

 

Required Hardware 1,5 GHz PC 

1 GB RAM 

DVD-ROM drive  

Network adapter 

Graphics with a resolution of at least 1024 x 768, 32 MB RAM 

16Bit color and DirectX 7 

Required Operating 

System 

Windows® 10 x64 (Build 1703 or higher) 

Required Free Disk 

Space 

3 GB (not including the size for application data) 

 

The following system prerequisites are recommended: 

 

Required Hardware 2,0 GHz Dual-Core PC or equivalent 

16 GB RAM 

DVD-ROM drive 

Network adapter 

Graphics with a resolution of 1920 x 1200, 256 MB RAM 

Required Operating 

System 

Windows® 10 x64 (Build 1703 or higher) 
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Required Free Disk 

Space 

>4,0 GB 

Required Software Microsoft® .NET Framework 4.6.2 or later 

Microsoft® Visual C++ Redistributable Package 2010 SP1 

Microsoft® Visual C++ Redistributable Package 2015 SP2 

2.2.3. Software Prerequisites 

 

You ensure that your PC has the following Microsoft® redistributables installed before installing 

ASCET: 

• Microsoft® .NET Framework 4.6.2 or later 

• Microsoft® Visual C++ Redistributable Package 2010 SP1 

• Microsoft® Visual C++ Redistributable Package 2015 SP2 

ASCET V6.4 cannot be used without installing at least one of the product executables: 

• ASCET-MD V6.4 

• ASCET-MDV V6.4 

• ASCET-RP V6.4 

• ASCET-SE V6.4 for a microcontroller target. 

Any combination of these products can be installed once ASCET V6.4 is present. For details see the 

ASCET Installation manual. 

ASCET uses XML technology for code preview and code documentation. Please see the “Hints” 

section for details on the required software installation. 

2.2.4. Access Rights 

2.2.4.1. Administrator Rights 

Administrator rights are: 

• Mandatory for installation 

• Optional for normal operation 

2.2.4.2. Registry Access 

ASCET places data in the Windows registry and requires read/write access to the following locations: 

• HKEY_LOCAL_MACHINE\Software\ETAS 

• HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\{57C37195-98DD-43E8-BFF0-

5015215B15FA} 

• HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{53C745C7-78D9-415f-8215-

D1E8B652E5CF 

• HKEY_LOCAL_MACHINE\SOFTWARE\ETAS 
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• HKEY_LOCAL_MACHINE\SOFTWARE\ETAS\ASCET 

• HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\  

• HKEY_CLASSES_ROOT\Ascet.Ascet 

• HKEY_CLASSES_ROOT\Ascet.Ascet.6 

• HKEY_CLASSES_ROOT\Ascet.Ascet.6.4 

• HKEY_CLASSES_ROOT\Ascet.Ascet.6.4.7 

• HKEY_CLASSES_ROOT\CLSID\{A19A0268-9053-4ae8-BE50-C807A11245E2} 

• HKEY_CLASSES_ROOT\AscetServer.AscetServer 

• HKEY_CLASSES_ROOT\AscetServer.AscetServer.6 

• HKEY_CLASSES_ROOT\AscetServer.AscetServer.6.4 

• HKEY_CLASSES_ROOT\AscetServer.AscetServer.6.4.7 

• HKEY_CLASSES_ROOT\CLSID\{63C4AEF3-B847-4b01-B25D-319D0CF1C698} 

• HKEY_CLASSES_ROOT\.six 

• HKEY_CLASSES_ROOT\SCOOP-IX_file 

• HKEY_CLASSES_ROOT\SCOOP-IX_file\DefaultIcon 

• HKEY_CLASSES_ROOT\SCOOP-IX_file\shell 

• HKEY_CLASSES_ROOT\SCOOP-IX_file\shell\Open in Browser\command 

• HKEY_CLASSES_ROOT\ascet 

• HKEY_CLASSES_ROOT\ascet\shell\open\command 

• HKEY_CLASSES_ROOT\asd 

• HKEY_CLASSES_ROOT\asd\shell\open\command 

• HKEY_CURRENT_USER\Software\ETAS 

• HKEY_CURRENT_USER\Software\ETAS\ASCET 

2.2.4.3. File System Access 

ASCET requires access to the following file-system locations: 

 

Folder Default(s) Installation Use 

<installation folder> C:\ETAS\ASCETx.y RW RW 

C:\ETAS\LogFiles RW RW 

C:\ProgramData\ETAS\

ETASManuals\ 

RW R 

C:\ETASData\ASCETx.y RW RW 

C:\Program Files\ 

Common Files\ETAS 

 RW RW  

C:\Windows\System32  RW RW 

%ProgramData%\ETAS  RW RW 

%AppData%\Local\Temp  RW RW 

%AppData%\Roaming\ETAS  RW RW 

C:\Temp  RW RW 
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2.2.5. Release Test Configuration 

The ASCET release tests have been executed with the following configuration: 

• Host OS: 

− Windows® 10 x86_64 

• Compilers for host PC: 

− Microsoft Studio 2005 Express 

− Microsoft Studio 2008 

− MinGW GNU Compiler V11.3.0 

• Compilers for Prototyping targets: 

− MinGW GNU Compiler V11.3.0 

• µC on target testing: 

− MPC55xx, WindRiver Compiler V5.6.0 

2.3. Delivery 

The software is delivered with an installation routine on a DVD including ASCET software, 

documentation, tools, utilities, and further information. All software documentation is available in the 

Portable Document Format (PDF), which requires Adobe® Reader®. You find the installation link in the 

ToolsAndUtilities directory on the installation DVD. 
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The DVD contains the following items: 

Directory Meaning / Explanation 

ASCET V6.4 ASCET base system installation, including release notes 

ASCET-DIFF V6.4 ASCET Model Difference Browser installation 

ASCET-MD V6.4 ASCET Modeling & Design installation 

ASCET-MDV V6.4 ASCET Model Viewer installation 

ASCET-VIEW V6.4 ASCET Eclipse-based Model Viewer installation 

ASCET-RP V6.4 ASCET Rapid Prototyping installation 

ASCET-SCM V6.4 ASCET Software Configuration Management installation 

ASCET-SE V6.4 ASCET Software Engineering (for multiple targets) 

installation 

Documentation Documentation set for complete ASCET V6.4 product 

family (in PDF format) 

Graphic Graphical elements for the product installer program 

Main Main elements for the product installer program 

MDA V5.3 Measure Data Analyzer installation 

Partner ETAS Partner information for the product installer 

program 

Support ETAS customer support contact information for the 

product installer program 

ToolsAndUtilities ▪ ASCET-SCM_CM-Tool-Configuration 

(content also incl. in online help) 

▪ ASCET-SCM_Difference Browsing 

▪ ASCET-SCM_Driver Toolkit 

▪ ASCET-SCM_Subversion Client V1.6 

▪ ASCET-SCM_Subversion ScriptingAPI Example 

▪ CaliberRM Coupling 

▪ Licensing Tools for FlexLM 

▪ MikTex Documentation Generation 

▪ OpenSourceSoftware 

▪ WebService Example 

2.3.1. Used 3rd Party Software 

ASCET makes use of products that are released under the respective licenses. 

For details, please refer to the following documents on the DVD under the folder: 

\ToolsAndUtilities\OpenSourceSoftware\ 

2.4. Installation  

You must install the following Microsoft® Redistributables before installing ASCET: 

• Microsoft® .NET Framework 4.6.2 or later 

• Microsoft® Visual C++ Redistributable Package 2010 SP1 

• Microsoft® Visual C++ Redistributable Package 2015 SP2 
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These are available from Microsoft. 

After you have installed the r, follow the installation instructions on the DVD installer or the ASCET 

installer.exe. Further details are available in the installation manual [ASW_INST_EN]. 

2.5. Licensing 

The use of ASCET products is protected by electronic licensing. Valid licenses are necessary to install 

ASCET and its add-ons. The use of unlicensed ETAS software is prohibited. The required licenses are 

not included in this delivery. 

When you purchase ASCET licenses, you receive a separate entitlement letter. You activate the 

license using a self-service portal on the ETAS website (https://www.etas.com/support/licensing). For 

assistance, please consult the help file available on the start page of the self-service portal. During the 

activation process, you receive the necessary license keys per E-mail. 

3. Changes  

This chapter describes changes with respect to the previous version of ASCET V6.4.6. 

3.1. What’s New  

The following changes have been made with this release: 

• ASCET uses the VAST 64bit framework now. So, ASCET V6.4.7 is a genuine 64bit application. 

• MinGW GCC V11.3 has been introduced for the PC simulation target 

• Code Generator uses Perl V5.32 64bit. 

• EHOOKS 

− Updated to add support for EHOOKS V4.12 and V5.0 

− Support for EHOOKS V4.8 and V4.9 has been removed 

3.2. Compatibility to Earlier Releases 

ASCET V6.4.7 is functionally upwards compatible with previous versions. 
 

 NOTE 
 

There are no known Database incompatibilities to ASCET V5.0 / V5.1 / V5.2 / 

V6.0, V6.1, V6.2 & V6.3. 

 
   

ASCET V6.4.7 can import or read models that have been created with ASCET-SD V4.0.16 or higher.  

Before exporting or converting the database, a database defragmentation (menu 

Tools→Database→Performance Utilities→optimize database) is recommended. For older models, you 

have to import and export them with ASCET-SD V4.0.16 or V4.1.x first. 

https://www.etas.com/support/licensing
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After opening a database that was created using a previous ASCET version (e.g. ASCET-SD V5.2.2 

or V6.1.x), ASCET asks if you want to convert the database (see screenshot below). If you answer 

with yes, a path selection dialog is opened, and you can define the destination directory for the 

database conversion. A new ASCET V6.x database is created in that directory. The original database 

remains untouched. The converted database is now usable with ASCET V6.x but no longer with the 

old version.  

A similar conversion is made for export files (*.exp) created with previous versions. 

 

 

 

If you encounter difficulties in using your ASCET V5.x or V6.x Database under ASCET V6.4, please 

contact your local ETAS Hotline. 

 

 NOTE 
 

ASCET V6.4.7 provides *.amd export compatibility for the following legacy 

versions: 

▪ V5.2.2 
▪ V6.0.1 
▪ V6.1.4 
▪ V6.2.1 
▪ V6.3.1 
▪ V6.4.0 
▪ V6.4.1 
▪ V6.4.2 
▪ V6.4.3 
▪ V6.4.4 
▪ V6.4.5 
▪ V6.4.6 
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3.3. Fixed Problems 

This section describes the set of fixed problems of the released version of ASCET V6.4.7. 

 

286285 Inputs of CT blocks cannot be dropped more than once in BDE 

ASCET does not allow to drag & drop a graphical instance of input for CT blocks 
WHEN there already is another instance of the same input placed in same block 
diagram. 

286498 Class Interface Editor doesn't accept changes, if second Interface Editor of 

another Class is opened 

ASCET does not save changes in the Method Signature Editor 
WHEN a Method Signature Editor of another class has been opened after the first 
one. 

286514 PC Experiment: Write back implementation destroys implementation 

ASCET changes the implementation type of variables to 'real64' 
WHEN the simulation experiment is running as "Quantized Physical Experiment" 
AND the calibrated implementation settings are written back by Edit-
>Implementation->Write Back 

287012 Editing of arguments does not work 

Changes to the attributes of method elements are not persisted correctly if multiple 
editors have been opened. 

312259 Export of amd-files fails if destination files exist and are write protected 

Export of amd-files fails if destination files exist and are write protected, and 
unsightly error message is shown in this case. 

344057 System error when opening a component 

ASCET runs into a system error  
WHEN an integer element is assigned to an enumerator element 
AND the value range of the integer exceeds the number of possible enumerator 
values 
A walkback occurs: 
Primitive failed in: Object>>#at: due to Index out of range in argument 1  

394487 Speedup compression/decompression of axl-/zip-files in ASCET 

The compressions and extraction of AXL file should be accelerated. 

523938 Measurement of integer variable in PC experiment shows deviation from 

expected value 

ASCET displays a measurement variable in the PC experiment with a little deviance 
WHEN using the Implementation Experiment 
AND the model contains a type conversion from float to integer 

539113 Fatal errors during importing an ARXML file 

A fatal error occurs when importing an ARXML file broken references. 
Instead a sensible error message such as follows should be shown: 
[ERROR] No mapped implementation type for Record Element 
/SWC/ApplicationRecordDataTypes/myARDT/myVal 

580009 Resolve Hierarchy does not work correctly 

Resolve Hierarchy does not work consistently for control flow connections and 
connected sequence calls. 

583867 Save-Toolbar-Button is always active 

The Save button in the Component Editor (Database or Workspace) is always active. 

587567 Walkback when selecting calibration editor for curves 

ASCET runs in a system error  
WHEN selecting calibration editor for curves 
A walkback occurs: 
(ExCLDTObjectNotFound) Object not found.  

587697 Some issues with large arrays/matrices 
ASCET shows unexpected behavior (Walkback, out of memory exception, wrong 
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displayed size information, etc.)  
WHEN large arrays or matrices are used 
AND the max size of these objects is changed by the user. 

590169 System error when using "Resolve Globals" for a write protected component 

ASCET runs into a system error  
WHEN a component is write-protected 
AND menu entry "Extras\Default Project\Resolve Globals" is used the binding of 
global elements may be corrupted and a walkback occurs during code generation: 
RBArithmeticElement does not understand asInterval 

592700 "WARNING(WIa91): Loosing precision" shown without justification for 

constants 

Arithmetic operations with constants are executed during code generation time suing 
float precision and must not cause warnings concerning integer arithmetic. 

599114 Parameter element has no  write access in calibration 

Write calibration flag gets lost when switching Scope setting of element 

608187 Bad representation of ASCET windows 

The representation of some windows is corrupted on Windows 10 with screen 
scaling differs from 100% 

614851 System error during search operation 

ASCET runs in a system error  
WHEN opening a component from the search results window 
A walkback occurs: 
SGReal does not understand isGenericComponent 

622910 Wrong values for system constants shown in block diagram 

The graphical representation for values of system constants from type limited integer 
is not updated in the block diagram editor. 

625062 Walkback when using copy/paste 

ASCET runs in a system error  
WHEN using copy/paste for a method argument in the Outline view 
A walkback occurs: 
UndefinedObject does not understand at:ifAbsent 

625214 Syntax highlighting lacks inner records as variables and method names 

The syntax highlighting and auto completion of label names in EDSL/C code editors 
does not work for members of records. 

629972 ARXML importer stops 

The ARXML import stops when trying to import shared maps and curves. 

632523 Search function does not work in Navigation view 

Navigation tree does not find and show searched strings in nested hierarchies 

633264 Ignore info, Starting with, Appending features do not work 

Automatic sequencing using Ignore info, Starting with, Appending features does not 
work for Statement blocks 

633281 Reset for method/process does not work 

Reset of sequence calls for method/process does not work. 

640370 Wrong implementation type check in Method Signature Editor 

ASCET performs a wrong implementation type check in the Method Signature Editor 
WHEN the method signature editor dialog is opened 
AND there is more than one argument in the method 
AND the arguments are of more than one implementation type 
AND one argument is selected 
AND the signature editor is closed 
The properties of all arguments are checked against the selected implementation 
type which may lead to an error message. 
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648674 System error when opening database or workspace 

ASCET runs into a system error  
WHEN a database or workspace should be opened 
AND the selected folder or subdirectory is damaged 
A walkback occurs: 
CfsError does not understand dName 

650764 Impossible to create Statement Block with IF condition 

ASCET rejects the creation of the statement block 
WHEN the user tries to encapsulate some selected graphics objects of a block 
diagram editor into a new statement block 
AND the list of selected graphic objects contains an IF statement 

651094 IDTs not imported correctly 

References to AUTOSAR Implementation Data Types are not imported correctly 
from ARXML file. 

651431 Storing problem of external code (C-, H- and object code) 

ASCET stores unexpected external C code 
WHEN the contents of an external specified file in the External Source Code Editor 
are reduced in the number of characters 
AND the related C code component is persisted by using the AMD format 
(workspace, export) 
ASCET does not reduce the file size accordingly to the new contents. The former 
specified information at the end of the file is still available. 

653449 Menu "hide unconnected ports" with defined sequence calls does not work 

correctly 

If a sequence call of a class method is assigned (even though the argument pin is 
not connected) it should not be hidden, since the user cannot see the incomplete 
modelling before the code generation throws an error. 

653665 Wrong pointer declaration of group structs 

A const qualifier is missing when accessing a parameter struct member. 

654473 Analyze Diagram in state machines shows unexpected errors 

The "Analyze Diagram" feature may cause false positive errors when analyzing 
statemachines. 

654639 Violation of MSIRA Rule 1.1 

MISRA Rule 1.1 is violated by the generation of an enumeration type which is 
provided by the RTE already. 

656649 Walkback during sorting 

ASCET runs in a system error during sorting Mappings 
A walkback occurs: 
Undefined Object does not understand displayName 

657725 Incompatibility error when saving Tool Options 

False error concerning hardware settings is reported when saving tool options. 

657954 System error when opening a component 
ASCET runs in a system error  
WHEN opening a component is opened 
AND the request for sufficient GDI handles fails due to missing registry keys 
A walkback occurs: 
UndefinedObject does not understand - 

657997 Matrices as arguments are generated flat like Arrays 

Although the target option "Number of Dimensions for Fixed Matrices" is set to "Two 
Dimensional" matrices are generated as flat arrays in the C code. 

658326 Element is created on the canvas with wrong properties 

If a new element is created in a Software Component and its properties are changed 
in the Properties dialog it can be placed in the block diagram right away. In this case 
the properties of the element in the diagram are not updated correctly. 
  

658444 Uninstallation of ASCET does not remove all entries from registry 
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Uninstallation of ASCET does not remove all entries from the Windows registry 
because of remaining artefacts of hotfix or addon installations. 

660468 System Error during code generation 

ASCET runs into a system error during code generation step 
WHEN A fixed look-up table with only one axis point 
A walkback occurs: 
UndefinedObject does not understand <  

662996 Wrong import as Boolean from ARXML 

ASCET wrongly imports elements from an ARXML file 
WHEN the value range is restricted to [0 .. 1]  
Even though the BASE-TYPE-SIZE of the Basic Type in the ARXML file is greater 
than 1, the element is imported as "Boolean" Implementation type. 

664868 Missing variation points on unused port 

Missing variation point information for unused port in generated ARXML file with 
activated target options "Variant Coded Data Structures" and "Compile Unused 
Data". 

665591 Wrong comment "no version number will be appended" in install.ini 

A wrong comment "no version number will be appended" in the install.ini for MainDir 
and MainDataDir entries 

667154 Missing warning for inconsistent specification (wrap-around integer) 

ASCET shall generate a warning  
WHEN a wrap-around integer is specified using different min/max values than given 
by the interval of the associated implementation type 

667175 Corrupt data created in Asian Windows environment 

ASCET creates corrupt data and may run into a system  
WHEN an Asian OS is used (two-byte characters OS, e.g. Japanese, Chinese, 
Korean, ...) 
AND database objects containing strings are edited or newly created  
OR a database repair is executed 
These objects are handled and saved incorrectly. The result is that these database 
objects are no longer usable. 
A walkback occurs: 
ByteArray does not understand compareNumericWith 

670239 Tool-API method does not persist changed settings 

The Tool-API method ReadCodeGenMessagesFromXMLFile() does not mark the 
related project as modified after changing the code generation message settings. 
Hence, it may happen that its setting gets lost when closing ASCET. 

671602 Duplicate C-Code name with multiple instances of CT-blocks 

ASCET code generation stops with an error message 
WHEN the project is generated using a Controller target 
AND multiple instances of CT-blocks components are used within the model 
ASCET wrongly complains about the same name used more than once in the global 
name space. 

671627 The Target Server component could not be installed 

Installation of the Target server fails due to corrupted batch files. 

671891 Struct element entry missing in AMD calibration parameter interface mapping 

Struct elements members are not available in AUTOSAR calibration interface 
mapping 

672034 Wrong RTE access macro in customer specific implementation 

ASCET generates wrong Rte Access read macro  
WHEN the project is generated in the AUTOSAR context 
AND a message is mapped to a record field of a SRInterface 
AND the SRInterface is listed in codegen.ini as any read access should be 
generated as explicit 
ASCET generates an Rte Access Macro with IMPLICIT access semantics. 
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672102 Wrong c-code type for service classes 

ASCET generates the wrong c-code type for service classes  
WHEN the target template for c-code type names of ASCET classes has been 
changed to "CamelCase" 
ASCET still generates the c-code type for the service class using uppercase  

672343 Rte_Read called via pointer instead of local variable 

ASCET generates wrong code  
WHEN the code is generated for the AUTOSAR context 
AND a READ access to a complex element, i.e. element typed as ARRAY or 
RECORD is used  
AND the access uses explicit semantics 
AND the data returned from the RTE_READ macro is not directly stored in a model 
element, thus the code generator introduces a temporary variable 
ASCET wrongly generates a pointer type for that variable instead of a non-pointer 
type to actually be able to store the returned data. 

672934 Error message when reimporting a component: 'interface isNil' 

ASCET wrongly reports an error 
WHEN a component is imported into ASCET 
AND the component already exists in the current database 
The consistency check for data & implementation wrongly reports 'interface isNil'. 

673170 Missing type definition in generated code 

ASCET generated code does not compile  
WHEN the project uses the AUTOSAR context 
AND Implementation Types are defined in the project and used 
The names of the used Implementation Types appear in the generated C-Code 
instead of their associated platform type. 

673196 System error when used as headless server 

ASCET runs into a system error 
WHEN generating code 
AND the model contains implementation casts in the branches of a multiplexer 
operator 
A walkback occurs: 
UndefinedObject does not understand at:ifAbsent 

673833 Missing warning for incomplete CSI mapping 

When using Asynchronous Client Server Communication no warning is shown if 
return type is missing in the prototype method. 

673936 RTE Error if Application Error is used as return value and multi-instance is 

selected 

When using Asynchronous Client Server Communication an error is show if an 
Application Error type is used as return value and multi-instance is selected. 

674253 System error during code generation 

ASCET runs into a system error 
WHEN the model uses FIXED characteristic tables 
AND the project option "optimized Direct Access" has been activated  
AND the access to a FIXED characteristic table element is done via a direct access 
A walkback occurs: 
UndefinedObject does not understand varDecl 

674327 Cannot copy/paste Impl. Min/Max for Limited Integers in Implementation view 

Copy/Paste of Min/Max attributes of implementation for Limited Integer types does 
not work in Browse view of component. 

674333 System Constants: Wrong import as logic basic type from ARXML 

ASCET wrongly imports System Constants from an ARXML file 
WHEN the value range is [0 .. 1] 
Even though the Implementation Data Type in the ARXML file is not "Boolean", the 
System Constants are imported as "logic" basic type. 
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674336 False WARNING(WIle52) is generated for messages in C Code modules 

False warning WIle52 if Interrunnable Variables are used in C Code modules.  
675125 Subcomponents are not removed completely when uninstalling ASCET 

Several programs / folders / files and registry values not deleted when uninstalling 
ASCET. 

675891 New IN/OUT pins of a hierarchy may be hidden behind a sub hierarchy 

WHEN a new input or output pin is added to a hierarchy 
AND there is a sub hierarchy 
THEN the pin may be hidden by the overlapping sub hierarchy 

676105 Multiple mapping of NV data variables handled incorrectly 

ASCET code generation misses to show an error  

WHEN mappings in the AUTOSAR context are used  

AND a non-volatile variable is mapped to two different data elements via associated 

require ports 

676784 ScaleToStepSize does not work in statement blocks for sequence calls 

Automatic assignments of the does not work for sequence calls in statement blocks. 

676785 Missing sequence calls for statement blocks in navigation view 

ASCET does not show a Sequence Calls in the Navigation Tree 
WHEN it is modeled under a statement block 

676811 Erroneous navigation with CTRL arrow key in statement blocks 

ASCET may fail to jump to the next/previous Sequence Call 
WHEN the user navigates inside a Statement Block 
AND the Ctrl + Left/Right keys are used in the block diagram Editor 
An arbitrary other sequence call is selected instead. 

677032 Show unused Elements lists referenced messages of type Record 

ASCET wrongly lists messages in the result list of 'Show unused elements' 
WHEN these messages are of type Record 
AND the messages are referenced (e.g., mapped in a Software Component) 

677511 System error during code generation 

ASCET runs into a system error during code generation 
WHEN a switch statement is used  
AND one or more associated case statements use constant arithmetic expressions 
instead of a constant only as "literal", e.g., sysconst + 1 
The code generation aborts with a walkback: 
UndefinedObject does not understand isFloatContext 

677872 Superfluous limit code for float typed elements 

ASCET generates wrong limit code for float typed elements  
WHEN an Implementation specific code generator is used  
AND the Integer Arithmetic Option "Generate Float Limiter on Assignment" has been 
enabled 
AND a float typed element does have limits specified 
AND the float typed element is part of an expression which is assigned to an integer 
typed element 
ASCET generates superfluous limit code taken from the float typed element prior to 
the assignment to the integer typed element. 

678130 "Show unused Elements" shows incorrect results 

"Show unused Elements" shows incorrect results due to inconsistent and not 
updated references. 

678263 Connection via mouse over and popup for elements of a structure is not 

possible 

The connection dialog for structure elements in the block diagram does not work. 

678564 Complex Calibration Interface elements are imported as variable instead of 

parameter 

Struct elements are imported with kind variable instead of parameter for a calibration 
interface during the ARXML import. 
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678598 System error when opening block diagram view for AUTOSAR components 

ASCET runs into a system error  

WHEN an ARXML model is imported into an existing database 

AND the ARXML overwrites elements with a different type 

AND afterwards a block diagram view using these elements is opened 

A walkback occurs: 

SGDataGO does not understand createSymbolGO: 

679751 Redundant assignment in generated C code 

The generated code contains a redundant assignment (e.g., _ t1sint16 = _t1sint16;) 

681343 Problem with special characters in ASCET webservice API 

Exporting files via Web Services fails if target path contains special characters (e.g., 
"ä", "ü", ...) 

682060 System error when using customer specific Engineering enhancement 

ASCET runs into a system error 

WHEN graphics are exported from a BDE 

AND Traceability text is included 

A walkback occurs: 

Signal does not understand defaultAction 

682617 Remove erroneous mnemonics from component manager 

The mnemonics of the component manager have been set into function with a 

workaround that is not available with the updated development framework. They are 

presented erroneously, now (with &1, &2, ... marks). They shall be removed 

completely. 

683358 System Error during when writing DCM for a map with less values than 

expected by its axis 

ASCET runs into a system error 
WHEN a DCM file is written for the data of a map 
AND due to an inconsistency in the data model this map has less values than its 
distribution requests 
A walkback occurs: 
Primitive failed in: Object>>#at: due to Index out of range in argument 1 
(1188417863) 

683724 Show unused elements does not work correctly for record elements 

ASCET wrongly shows elements as unused 
WHEN nested elements of records are used in the block diagram editor 
AND they are searched with the feature 'Show unused Elements'  

683828 No warning in code generation for empty statements 

Empty Statement under If statement of an ESDL trigger in a statemachine shows no 
warning 

684889 Wrong code when using compile-time system constants on multiple MUX 

operators 

ASCET generates wrong code  
WHEN the target settings System Constant Resolution are set to COMPILE-TIME  
AND a System Constant is used as part of the conditional expression of a MUX 
operator 
AND one of the connections to the MUX contains another MUX operator  
AND the inner MUX operator contains expressions where a temporary variable is 
generated in order to avoid recalculation, e.g. a MAX operator 
The algorithm used to keep track of the usage of the temporary variables gets 
confused and uses temporary variables which have not yet been assigned to in the 
respective path of the MUX. 
 
  

685583 Unneeded WMdl95 in statemachines 
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A warning is issued even though it is not justified: WARNING(WMdl95): method 
argument "arg" possibly not assigned, but needs assignment because of OUT 
direction 

685590 Code generator generates duplicate typedefs 

ASCET generates multiple typedefs with the same name 
WHEN the project is generated in the AUTOSAR context 
AND an array/matrix type is used for non-AUTOSAR elements  
The generated code does not compile. 

685971 Target option "Guarded typedef" 

ASCET introduces a new target option "Guarded typedef" to generate C 
preprocessor directives to avoid duplicate definitions on typedefs on c-code level. 

686679 "Find and Replace" in C editor wrongly overwrites Header code 

ASCET wrongly overwrites the Header code with the C/ESDL Code in the C code 
editor 
WHEN the Header code tab is selected 
AND the function "Find and Replace" is used in combination with "Replace All" 

686686 AMD/AXL export with referenced items causes assertion if flexible class layout 

is used with nonstandard icon 

ASCET causes an assertion when exporting components in AMD/AXL format in case 
the "Flexible Class Layout" option is active, and a custom icon is used. 

687002 Error during axl import 

ASCET wrongly shows an import error during the import of an AXL file 
WHEN it contains a model with BDE elements created with the function 'Send to 
Back' 
AND these elements are inside hierarchies 

687823 Common Subexpression Elimination generates broken Code for switch 

statements with non-empty fall through 

ASCET generates wrong code 
WHEN the user writes ESDL code with a switch statement 
AND common subexpression elimination is enabled 
AND one of the cases (called case "f") has fall through behavior (into the next case, 
called case "g") 
AND the case "f" is not empty, i.e., it contains any non-empty statement before 
falling through into case "g" (please note that the model triggers the warning 
WMdl885) 
AND there is a (sub-)expression present in all cases that could be extracted if there 
were no fall through 
AND one of the variables used in the subexpression is overwritten in case "f" before 
the subexpression occurs again in case "g" 
ASCET generates wrong compilable code by extracting the subexpression, so that it 
is not re-evaluated after the variable is overwritten.  

688344 Using system constants as maxsize, wrong matrix dimension is generated 

Variant size matrices are generated as two-dimensional even though the target 
option is set to one-dimensional. 

688879 Sequence Call navigation is not possible for nested structures 

Sequence Call navigation is not possible if a nested structure statement block -> 
hierarchy -> statement block is used. The sequence calls are not shown completely. 

689198 Connection to EHOOKS fails 

When starting EHOOKS from ASCET project the system hangs.  
690275 ASCET overwrites temp vars used in loop condition 

ASCET generates wrong code 
WHEN the model contains a WHILE- or FOR-loop 
AND the code generator introduces a temporary variable that is only used in the 
condition of the loop 
AND the code generator needs another temporary variable in the loop body 
The code generator wrongly reuses the temporary variable, overwriting its content. 
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690728 ECU variable selection fails 

The ECU variable selection from EHOOKS cannot be opened for the input variables. 

691636 Wrong optimization for arithmetic 

ASCET may generate wrong code 
WHEN the code generator is configured for "object based controller physical" or 
"physical experiment" 
AND the model contains an expression with sub-expressions, where one of the sub-
expressions is of type udisc 
AND the value of the expression is always less or equal to zero 
ASCET might wrongly substitute zero for the expression. 
(e.g.: B = A + -2 * C is transformed into B = A, where A, B and C are all of type 
udisc).  

694270 Inconsistent models after deletion of arguments of child class methods 

Inconsistent models are not detected by the code generation when the arguments of 
child class methods are deleted. 

694640 Inconsistent AUTOSAR mapping 

The AUTSAR message mapping to interfaces may not work in a deterministic way. 

695186 System error during code generation 
ASCET runs into a system error during code generation 
WHEN accessing an extended input value on a method call without arguments 
A walkback occurs: 
(ExCLDTIndexOutOfRange) Index out of range.: 1 

695363 Duplicate entries shown in implementations page when importing AMD 

ASCET may show duplicate entries in the Implementation page 
WHEN components are imported from an *.amd file  
AND a component contains Wrap-Around or Limited Integers 
An immediate look onto the Implementation page of this component may show 
duplicate entries for the elements. 

696143 Reproduce As caused system error 

ASCET runs into a system error 
WHEN the menu Edit > Reproduce As > ESDL is used 
A walkback occurs: 
SGESDLCodeStream does not understand lineComment 

697599 Wrong error MMdl6 during code generation 

ASCET reports a wrong error MMdl6 during code generation 
WHEN an AUTOSAR interface is used 
AND this interface is represented by multiple objects with different contents 

697730 References to a signal object may get lost if it is renamed or reimported in a 

workspace 

If a signal item is used in a workspace and is renamed or reimported the reference to 
the MDF data file gets lost. 

697739 Missing unit in generated DCM file for axis 

Imported axes of group tables do not get the unit entry in the generated DCM file. 

697995 Walkback during ASCET OTB Build 

ASCET runs into a system error  
WHEN generating code for an EHOOKS On-Target-Project 
A walkback occurs: 
UndefinedObject does not understand checkForExistentMakelog 

698305 ESDL method between() does not return log type 

A code generation error is thrown if an In/Out argument is used with a Between 
operator in ESDL code: 
ERROR(MMdl6): type mismatch: expected <cont> (<(Between-Expr)>), got 
<readWrite*cont> (<arg>) 

698708 Missing propagation of empty Server Interface to Provider Port 

A Server Interface has empty runnables only, the operation invoked events and the 
runnables get a variation point with the corresponding system constant. 
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In this case the propagation of all empty runnables to the whole provider port is 
missing. 

699273 Local message of record type is not initialized 

Messages of type record and scope local are not initialized. 

699695 System error during code generation for AUTOSAR project 

ASCET runs into a system error  

WHEN code generation for an AUTOSAR target is used 

AND a method uses the implementation setting "Prototype Implementation" 

AND system constants for variant code generation a used 

A walkback occurs: 

UndefinedObject does not understand ileNativeInitValue 

701295 System error when importing broken model 

ASCET runs into a system error  
WHEN importing a corrupted *.exp file 
A walkback occurs: 
Primitive failed in: Float>>#* due to Floating point underflow 

701755 Missing write back of temporary variable 

The result of an incremented temporary variable is not written back to the original 
static variable in the generated code when using the project option "common 
subexpression elimination". 

702393 System error in code generation for multiplex operator 

ASCET runs into a system error 
WHEN code is generated for a model 
AND Implementation casts are used in the branches of a multiplex operator. 
A walkback occurs: UndefinedObject does not understand getImplType 

702631 System error with toolbar of write protected AUTOSAR Software Component 

ASCET runs into a system error 
WHEN clicking on an non-disabled button in the palette of a block diagram Software 
Component 
AND the Software Component is write protected. 
A walkback occurs: 
SGViewController does not understand addOperator:arguments: 

704183 Distribution of a curve cannot be copied to another curve 

It is not possible to copy the values of a distribution of a group table to another 
distribution. 

704220 Addresses for 2d matrix elements missing in A2L-file 

For matrix elements no addresses are available in the generated a2l file.  
The build process shows a warning: 
Monitor Log shows lots of messages: 
Getting VAT file ... 
WARNING: No addresses for: <element_name> in map file 
D:\ETAS\ASCET6.4\CGen\temp_vat.s19 

704255 Naming of variables for message copies is not deterministic 

Automatically created temporary variables for message copies may need to be 
shortened. The pattern to rename them according to the maximum allowed label 
length may lead to variant names in different code generation runs. 

706443 Unjustified ERROR(MMdl710): illegal value for case literal - does not match 

switch entry expression type <udisc> 

If a switch operand is calculated from unsigned input values but the result might be a 
negative value an appropriate cast to a signed variable is missing. 

707472 Dependency formulas in generated a2l file do not comply to ASAM standard 

The usage of logarithm functions in dependency formulas is correct according to the 
ASAM-2MC specification. 

708931 Changing the used target for a project does not remember the OS settings 



Release Notes | ASCET V6.4.7 

 

Template: 00TE00156 Release Notes V07 – released Page 24/30 

In case the target of a project is changed back to a previously selected target the 
former OS settings are not recovered. 

712667 System error when using a write protected folder for Executer Output path 

ASCET runs into a system error  
WHEN the write access to the Executer Output Path is not possible because it is 
write-protected. 
A walkback occurs: 
Primitive failed in: Behavior>>#new: due to Invalid class in argument 1 

713318 "Always on top" is always disabled in experiment view 

The "Always on top" button in the experiment is always disabled even though it 
works as expected. 

 

3.4. Known Issue Reports 

If a product issue develops, ETAS will prepare a Known Issue Report (KIR) and post it on the internet. 

The report includes information regarding the technical impact and status of the solution. Therefore, 

you must check the KIR applicable to this ETAS product version and follow the relevant instructions 

prior to operation of the product. 

 

The Known Issue Report (KIR) can be found here: 

 

http://www.etas.com/kir  

3.5. Known Issues 

This section describes the set of known problems of the released version of ASCET V6.4.7. 

ID 

[EHI ID] 

Title 

293145 

[50828] 

1GEE Online Experiment: Change measure rate is always grayed 

out 
  

After adding a variable to a measurement window, the acquisition rate 

(alias raster / OS task) cannot be changed later on because the entry 

in the context menu is always disabled (grayed out). 

293808 

[52675] 

Virtual Parameter not calibrate-able in offline simulation 
  

Virtual variables are calibratable, but virtual Parameter are not 

calibratable in offline simulation, see attached example. 

=> v_param is defined as Existence: virtual 

=> v_param is defined with Calibration: YES 

297593 

[68869] 

Offline experiment: Hierarchy States not correctly reinitialized 

when Hierarchical CGEN 
  

In the ASCET offline PC-experiment, hierarchy state variables in 

State Machines are not reinitialized when "Experiment Stop" and 

"Reinitialize Both" is executed. 

The workaround is, to close and open the experiment whenever a full 

initialization is required. 

http://www.etas.com/kir
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304106 

[90653] 

Data buffer returned from target has invalid length, the error 

occurred while retrieving the pseudo address for ... 
  

ASCET supports only components with a maximum of 999 methods 

(including direct access methods) when running an experiment on an 

experimental target. 

334631 Code Generation fails after conversion to ASCET V6.1 when 

array or matrix of kind "parameter" is used as method argument 
  

If a method component, using an array or matrix as method argument, 

is converted to ASCET V6.1 or higher, 

ASCET enables the new introduced IN and OUT attributes for this 

argument to ensure that it is possible to write to the array or matrix 

argument within the method code. 

ASCET code generation fails 

WHEN the converted method is called by another component by 

using an array or matrix of kind "parameter" 

The code generator will report the error MMdl104 since parameters 

are not writeable. 

Workaround: The OUT attribute must be unset for the array or matrix 

argument in the method definition. 

349823 MSVS-2005..2008 compiler defect with floating point precision 
  

Due to a known issue of the Microsoft Visual Studio Compiler 

2005...2008 in certain cases a rounding issue occurs → wrong 

floating point values. 

Citation from: 

http://msdn.microsoft.com/en-

us/library/e7s85ffb%28v=vs.90%29.aspx 

with topic compiler configuration /fp (Specify Floating-Point Behavior): 

With /fp:precise on x86 processors, the compiler will perform 

rounding on variables of type float to the proper precision for 

assignments and casts and when passing parameters to a function. 

(...) 

704753 Moving dialog boxes 

In case the scaling or resolution of the PC is changed while running 

ASCET- even by connecting/disconnecting of external screens - child 

dialogs (like e.g. import dialog) are moving automatically 

unexpectedly on the screen. After a restart of ASCET the problem 

does not occur anymore. 

712375 Path settings with spaces 

In the tool options you can set different paths to folders used by 

ASCET under Environment->Paths. Paths with spaces must be 

specified with " at the beginning and end (e.g., "C:\Program 

Files\ETAS\ASCET6.4"). 

 

 

4. Hints 
   

http://msdn.microsoft.com/en-us/library/e7s85ffb%28v=vs.90%29.aspx
http://msdn.microsoft.com/en-us/library/e7s85ffb%28v=vs.90%29.aspx
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 NOTE 
 

Code generation 

It is recommended to perform a clean code generation directory before doing 

a complete project build. Otherwise, ASCET may not consistently consider all 

changed options during make. 

 

4.1. Release Notes 

These release notes are copied to the ETASManuals\ASCET V6.4 folder during installation and can 

be opened from there. 

4.2. Installation issues with Virus Scanner Tools 

In certain cases, an active Virus Scanner may cause a failing installation process. It is recommended 

to deactivate the Virus protection for the installation sources and the Ascet.exe installation process. 

4.3. Performance 

As consequence of the migration of the tool framework to a 64bit environment and other general 

improvements there might be an expected loss of performance particularly in the code generation 

process. 

4.4. XML Workspace and Export/Import 

For externally created or adapted XML files compliance to the XML schemas (to be found in the 

installation directory of ASCET) is important to obtain consistent and readable ASCET components. 
 

 NOTE 
 

Operating ASCET's GUI during import of *.axl & *.amd files 

During import of the XML-based description files (*.axl or *.amd), it is possible 

to operate ASCET’s GUI. This is not recommended, as inconsistencies of the 

manipulated ASCET objects may occur. 

Please do not work with ASCET during import of *.axl or *.amd files. 
   

It is not possible to create folder hierarchies/components with pathnames exceeding 180 characters, 

for legacy DBs or imported components a longer pathname is possible, but ASCET V6.4.6 won’t 

export such components/folders. The user will be notified to reduce the path length by renaming/move 

the respective component. 
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4.5. Double Byte Characters are Not Supported 

ASCET does not support the use of double byte characters. You may use double byte Characters, but 

the correct post processing for documentation can not be assured. The ASCET code generation is not 

affected as ANSI-C does not make use of double byte characters. 

4.6. Removal of Borland V4.5 for PC experiments  

With ASCET V6.4 the shipment of the Borland V4.5 Compiler with the ASCET installation has been 

discontinued.  

From ASCET 6.4.7 on the default compiler for the PC experiment is the MinGW GNU Compiler 

V11.3.0 which is part of the delivery. 

 

4.7. Passing OUT arguments in block diagrams 

To pass an element as an OUT argument, it is required to connect the get-pin with the argument pin. 

However, this was not possible for send-messages or other OUT arguments, because the get-pin was 

not enabled. This has been improved for non-scalar elements, where the get-pin can now be activated 

for this purpose. 

Each graphical instance of an OUT argument or a send-message can have a get-pin which is enabled 

by right-click and choosing “Extra Reference Connector” from the context menu. 

4.8. AUTOSAR improvements 

When importing AUTOSAR ARXML files SWCs and interfaces are created automatically and can be 

used for modelling. If available, the AUTOSAR Importer also collects the information about the usage 

of interfaces and ports (e.g., which runnable can be use which interface) 

A new option “Use Imported ARXML Info” has been introduced in the ARXML configuration setting. If 

the option is set to “Match” or “DeriveAndMatch” the usage information will be considered in the code 

generation step.  

For the setting “Match” a code generation error may be shown in case the model contains an interface 

access which is not allowed according to the contents of the ARXML file (e.g., port access is not 

allowed in a certain runnable). For the setting “DeriveAndMatch” the code generator tries to generate 

the code according to the ARXML information (e.g., implicit instead of explicit RTE access). In such 

cases a code generation warning is issued. 

Additionally, also variation point information in interfaces is taken into account if there are RTE 

accesses modelled with system constant conditions and the resolving of system constants at compile 

time. The variation point conditions (e.g., “SysConst == 1”) from the ARXML files available in the 

model and shown in the comment of the imported interfaces. In the code generation step these 

conditions are compared to the if-conditions using system constants in the model and a code 

generation warning is issued for mismatching conditions. 
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4.9. Code changes due to bugfixes 

The bugfix for PR700562 “Incompatible varstruct type leads to compiler error” caused a change in the 

generation of variable size arrays and matrices. 

For variable size arrays/matrices A special structure is used that contains a pointer to the values and 

the one or two max. sizes of the array or matrix.   

Instances of this structure shall be used to declare the variable array/matrix elements, and for the 

parameters/return values of functions that receive or return variable arrays. 

This special structure shall be used in the generated code for function parameters and return values if 

they are variable array references.  

The structure shall be used without a pointer redirection, i.e., as a fat pointer, in a call-by-value 

fashion. Function-local variables are also to be implemented as fat pointers, i.e., as instances of this 

special structure.  

Conversion from fixed array/matrix instances is achieved by construction of such an array. Conversion 

from a read-write structure to a read-only structure is achieved by creating a new structure and 

assigning the structure fields. 

Example V6.4.6: 

struct _ASCET_array_const_sint32_ref _t1_ASCET_array_ref_sint32_instance; 

_t1_ASCET_array_ref_sint32_instance.val = _myArray_REF; 

_t1_ASCET_array_ref_sint32_instance.size = 10U; 

MYCLASS_myCalc(&(_t1_ASCET_array_ref_sint32_instance)); 

void MYCLASS_myCalc (const struct _ASCET_array_const_sint32_ref * arr) 

{ 

   _i = arr->val[0U]; 

} 

Example V6.4.7: 

struct _ASCET_array_const_sint32_ref _t1_ASCET_array_const_ref_sint32_instance; 

_t1_ASCET_array_const_ref_sint32_instance.val = _myArray_REF_; 

_t1_ASCET_array_const_ref_sint32_instance.size = 10U; 

MYCLASS_AUTOMATIC_myCalc(_t1_ASCET_array_const_ref_sint32_instance); 

void MYCLASS_myCalc (const struct _ASCET_array_const_sint32_ref arr) 

{ 

   _i = arr.val[0U]; 

} 

4.10. Limit Assignments for Float Variables 

The “Limit Assignment” option in the implementation settings of float elements can be used like for 

integer elements now. 

If the option “Generate Float Limiter on Assignment (may be changed locally)” in the Project 

Properties (under Build->Integer Arithmetic) is active the local flag “Limit Assignment” will be 

evaluated, and limiter code is generated for the assignments to the element. 

Using the implementation flag in addition to the global flag allows the user a more fine-grained 

selection of the elements to be considered. 
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The limitation of a floating-point value is generated, if the global option in the Project Properties is 

active and the implementation type of the element is of float type and the implementation of the 

element representing the left-hand side of the assignment has an active implementation specific "limit 

assignment" flag and the limits of the associated element different value from +/- oo (INF). 

In such cases even the initialization value of the element gets limited automatically which is indicated 

by a code generation warning. 

 

 NOTE 
 

The “Limit Assignment” setting of float elements maybe deactivated in existing 

models by accident. So, for such elements the limitations may not be considered 

anymore due to the changed behavior of the Project Properties option. The 

same holds true for method/process local elements which do not have an 

implementation by default. 

 

4.11. Variable Size Arrays/Matrices 

When passing variable size matrices to methods this may cause the need of typecasts between 

different type descriptors for mutual and constant matrices 

To avoid these typecasts the semantic has been changed to call-by-value. 

Type descriptors contain only two or three (matrices) fields. In such case compiler can usually 

generate optimized code for such call by value arguments, by passing such values over the registers. 

4.12. Advanced Information 

The following options in Build in the ASCET project properties are deprecated and will be removed in 

the future: 

• Force parenthesis for Binary Logical Operators 

Parentheses will always be used. This change has no impact on behavior 

• Add parenthesis for readability 

Parentheses will always be used. This change has no impact on behavior. 

• Casting 

ASCET will use MISRA casting only in the future. 

• Allow Double bit Size for Division Numerators 

This option has no effect on 32-bit targets (because numerators cannot be doubled to 64-bit). 

The use case for 16-bit (ternary services with intermediate values of a larger value range) is 

now implemented independently of this option. 

• Use SHIFT Operation on Signed Values instead of MUL Operation 

ASCET will always use a MUL operation in the future. When this option is enabled it can 

change mathematical behavior and will break MISRA-C compliance. In modern optimizing 
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compilers, the compiler is intelligent enough to perform this optimization without needing a “hint” 

from code generation. 
 

The following options in Build → Code Generation → Optimization in the ASCET project 

properties will be deprecated in a future version of ASCET: 

• Optimize Direct Access Methods (One Level) 

Subsumed into the option for multiple levels  
 

The following options in Build → Code Generation → Optimization → State Machine in the 

ASCET project properties will be deprecated in a future version of ASCET: 

• Optimize Static Actions (Restricted Modelling) 

Disabling this option leads to state machine permits strange behavior with respect to execution 

order of static actions and transition conditions. This option will always be enabled, thus making 

models easier to comprehend. 

• Generate well-formed switch 

A well-formed switch will always be generated (as required for MISRA compliance). 

5. Contact, Support and Problem Reporting 

For details of your local sales office as well as your local technical support team and product hotlines, 

take a look at the ETAS website: 

 

ETAS subsidiaries www.etas.com/en/contact.php  

ETAS technical support www.etas.com/en/hotlines.php 

 

http://www.etas.com/en/contact.php
http://www.etas.com/en/hotlines.php

